Legal notices
# Contents

## Chapter 1: What's new
- New features summary ......................................................... 1

## Chapter 2: Workspace
- SpeedGrade workspace .......................................................... 5
- Desktop basics ........................................................................ 7
- Timeline basics ...................................................................... 8
- Playback basics ..................................................................... 10
- Compare frames with multiple playheads .............................. 12
- Work with projects ................................................................. 13
- Set up dual displays ............................................................... 15
- Direct Link workflow between Premiere Pro and SpeedGrade 16
- Image analysis tools ............................................................... 20
- Work with keyframes ............................................................. 23
- Adjust the display aspect ratio .............................................. 25
- Crop the display frame ........................................................... 26
- Adjust the display resolution for playback .......................... 26
- Keyboard shortcuts ............................................................... 27

## Chapter 3: Loading footage
- Supported file formats ........................................................... 33
- Load footage ....................................................................... 34
- Conform EDLs ..................................................................... 35
- Loading and conforming material .......................................... 36
- Load audio tracks ................................................................. 36
- Detect scene changes ............................................................ 37
- Using scene change detection ............................................. 38
- Display burn-in information on frames ............................... 38

## Chapter 4: Color grading
- Quickstart: Color grade a clip ................................................ 39
- Quickstart: Color grade a sequence ..................................... 41
- Adobe Premiere Pro and SpeedGrade workflows .................. 43
- Continuity Checker and Shot Matcher ................................. 44
- Snapshot View and Snapshot browser ................................. 47
- Work with masks .................................................................. 48
- Masking and Tracking ........................................................... 49
- Track a masked object through a shot ................................. 56
- Adjust color temperature ...................................................... 57
- Balance blacks and whites .................................................... 58
- Adjust gamma ...................................................................... 61
- Grade a specific tonal range ............................................... 62
- Secondary color correction .................................................. 63

Last updated 12/10/2014
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apply filters and effects</td>
<td>63</td>
</tr>
<tr>
<td>Adjust the framing of shots with pan and scan</td>
<td>63</td>
</tr>
<tr>
<td>Grade a specific color range</td>
<td>65</td>
</tr>
<tr>
<td>Stereoscopic workflows</td>
<td>67</td>
</tr>
<tr>
<td><strong>Chapter 5: Managing looks</strong></td>
<td></td>
</tr>
<tr>
<td>Working with Looks</td>
<td>68</td>
</tr>
<tr>
<td>Share and reuse looks</td>
<td>68</td>
</tr>
<tr>
<td>Apply Looks with Looks Manager</td>
<td>70</td>
</tr>
<tr>
<td><strong>Chapter 6: Rendering out</strong></td>
<td></td>
</tr>
<tr>
<td>Rendering out your project</td>
<td>71</td>
</tr>
<tr>
<td>Create proxy files for offline editing</td>
<td>71</td>
</tr>
<tr>
<td>Save an EDL</td>
<td>72</td>
</tr>
<tr>
<td><strong>Chapter 7: System Requirements</strong></td>
<td></td>
</tr>
<tr>
<td>System requirements for SpeedGrade</td>
<td>73</td>
</tr>
</tbody>
</table>

Last updated 12/10/2014
Chapter 1: What's new

New features summary

The 2014.1 release of Adobe SpeedGrade CC provides creative tools like Curve adjustments, Grading Layer Grouping, hover previews for Looks, and several other enhancements.

Read on for a quick introduction to the new features and links to resources offering more information.

Enhanced UI

Like other Creative Cloud video applications, this new release offers a refined new user interface with support for HiDPI displays, including Windows 8.1 systems.

The color scheme is more subtle and UI elements have been simplified. For example, the Effects menu has been organized to enable easy search. To view it, click the “+” icon at the bottom of the Grading Layer panel.

Effects pop-up menu is now organized into relevant groups as follows:

- Blur and Sharpen
- Color Match
- Curves
- Film
- Misc
- Stylize
- Video

Curve adjustments

Under Curves, there are two new color tool options:

- RGB Curves
- Hue & Saturation Curves

You can use curve adjustments on their own, or combine them with any other grading layers, Looks, or LUTs.

For more information, see Color Adjustments.

Grouping Grading Layers

With the 2014.1 release, you can now collect parts of your grade (or Look) and group them together. This grouping helps to create organized complex Looks. In addition, you can adjust the opacity of a group of grades in just one step. With this enhancement, it is easy to combine multiple Looks and effects, and create a Look remix. For more information, see Grading layer grouping.
Support for Blackmagic cards
This feature is new in this release. SpeedGrade provides support for Blackmagic cards.

User Interface enhancements

Hover to preview Looks
If you hover over a Look thumbnail, you can view how that Look impacts your image in the monitor. This feature makes it easy to test and compare Looks. For more information, see Share and Reuse Looks.

Enhanced vertical sliders for luminance control
SpeedGrade provides a bigger vertical slider in addition to the existing circular luminance dial on the Look panel. This change allows in editing and viewing the color scheme changes with much more ease. You can control luminance values in the image's shadow, midtone, and highlight regions using either the dial on the color wheels or the vertical slider. Also, the other color control options are now muted in the grading panel except for the active color control option being used. However, when you click any of the color control option, the option appears bright and you can perform the desired action.

Improved Direct Link
Improved Direct Link integration between Premiere Pro and SpeedGrade makes color grading easier and more flexible than before.

For more information on using Direct Link, see Direct Link workflow between Premiere Pro and SpeedGrade
What's new

Other changes

**New SpeedLooks**
In this release, new SpeedLooks have been added to the SpeedLooks package to provide you more out-of-the-box creative Looks.

SpeedGrade sports four new SpeedLooks, giving you even more options for sophisticated color grading presets that perform well across different types of footage and lighting conditions. You can group this look with grading layers to instantly create new custom looks.

SpeedLooks are available under their own tabs in the Look Manager.

**Audio Support for Premiere Pro projects**
Audio support is available for Premiere Pro projects in SpeedGrade. This feature allows you to hear the sound with the color. This new feature helps because soundtracks or dialog often provide cues for transitions in lighting.

**Performance with masks**
Performance with masks is now also improved, making it easier to work with masks in general, and multiple masks in particular. Related to this enhancement, SpeedGrade's tracking is now faster.

**Improved Autosave**
SpeedGrade also offers improved Autosave, both in Direct Link and in native SpeedGrade mode. This option is available in References > AutoSave to automatically save the files. The default number of saved project files is 20.

**Enhanced Mercury Transmit to support output to 4K monitors**
SpeedGrade has enhanced Mercury Transmit to support output to 4K monitors.

**Shared memory pool with other DVA apps**
SpeedGrade shares a memory pool with other DVA apps.

A memory balancer prevents swapping of RAM to disk by dynamically managing the memory allocated to each of the applications. Each application registers with the memory balancer with some basic information. The information constitutes of minimum memory requirements, maximum memory able to be used, current memory in use, and a priority. The priority has three settings: low, normal, and highest.
Chapter 2: Workspace

**SpeedGrade workspace**

The Adobe SpeedGrade workspace provides a more familiar screen layout for Adobe Premiere Pro users. There is a familiar placement of user interface elements such as the media browser, a redesigned auto-fit monitor, Look Manager, and integrated grading and mask panes.

The user interface contains a main toolbar and tabs on the upper right of the screen. The tabs are in the sequence of the SpeedGrade workflow: locating your media, grading, rendering, and reviewing the final output.

![Main Toolbar and Tabs](image)

**Main Toolbar**

Icons to open, save, redo, undo are available on the main toolbar in the workspace.

![Main Toolbar Icons](image)

Preference settings are available from a pop-up dialog when you select the Preferences icon on the main toolbar.
**Media Tab**

Click the Media tab to launch the new Media Browser. The Media Browser, formerly called the Desktop view, is the main interface for browsing through, locating, and loading your assets. Thumbnails of the files in the Desktop view are displayed in the Media Browser.

You can adjust the size of the thumbnails using the slider, and watch a quick preview of the video clip within the thumbnail.

**Color Tab**

Click the Color tab to view the Monitor panel and the Analysis Tools panel.

The Monitor panel lets you quickly scale, match shots, and color-grade your footage using the intuitive user interface. The Monitor panel automatically resizes to show the whole image. You can zoom in and out when required.

The Analysis Tool panel groups together the image analysis tools available in SpeedGrade. To view the Analysis Tool panel, click the arrow on the upper-left corner of the Monitor panel.

**Render Tab**

Click the Render tab to access the Output view for rendering out the completed project.

*Note: The Output view remains unchanged from the CS6 release.*
Result Tab
Click the Result tab to open the folder of the last render session.

Mask and Look panels
The Mask panel is now placed next to the Look panel. With the masking and grading tools placed side-by-side, you can now work faster on the mask workflow.

Desktop basics
Use the Desktop view to find and load footage. You can navigate to folders with image sequences, movie files, or RAW file formats. Thumbnails of the files are displayed in the Desktop view.

Show or hide the Desktop view
Press the D key.

Navigate to a folder
To navigate to a folder on your hard disk or network, use the breadcrumb control at the top.

You can also browse to a folder with the file browser on the left.

💡 You can adjust the size of thumbnails by dragging the Thumbnail Size slider.

More Help topics
- Load footage
- Support file formats

Filter the files in the Desktop view
If you have many files, you can filter them to display only the files with a specific filename extension or files starting with specific characters.

- To show or hide files, enter the filtering criteria in the text box in the upper right. Use the asterisk character (*) as a wildcard character.

For example, to display only files R3D filename extensions, enter *.R3D.

Refresh the Desktop view
Click the Refresh button. Refreshing the view is useful if you updated files while SpeedGrade was running.
Timeline basics

Playhead
The playhead displays a frame in the Monitor at any given position on the Timeline.

❖ Drag the playhead to move it along the Timeline.

To view more than one frame at a time, create additional playheads. Multiple playheads are useful for comparing different parts of the same shot or scene. For more information, see Compare frames with multiple playheads.

Tracks
Add tracks to the Timeline to generate layers for grading, add audio to the project, or to adjust the framing with pan and scan.

You can add the following tracks to the Timeline:

Footage Blue track. To add footage to the timeline, see Select a clip.

Grading Red track. To add a grading track, see Create a grading clip.

Audio Solid green track. To add an audio track, open the Desktop, locate the audio file (wav or aiff file), and drag it on the Timeline. Repeat this procedure with additional audio files.

To change values for sound output, such as the mixing frequency, select Settings > Sound. The Settings menu is on the upper-right corner of the SpeedGrade workspace.

Pan & scan Transparent green track. To add a pan & scan track, see Create a pan and scan track.

Manage tracks
You can manage the tracks on the Timeline with the tools on the left side of each track.

• To show or hide the track, click the Eye icon.
• To lock or unlock the track, click the Lock icon.
• To delete the track, click the Drag icon and drag the track off the Timeline.
Play a part of the Timeline

Specify the part of the Timeline to play by repositioning in- and out-points. The two points are located above the tracks, at either end of the clip or playlist.

Note: In- and out-points in SpeedGrade are not used to edit clips as in Adobe Premiere Pro. They’re used to control playback.

Do any of the following to reposition the in- and out-points:

• Drag the in- and out-points along the Timeline.
• Hold Shift to drag both points together.
• Control-click the in- or out-point to reset it to its default position.
• Double-click a clip to set the points to the start and end of the clip. Double-click again to set the points to the start and end of the Timeline.

💡 You can also double-click the in- or out-point icon and specify a frame number for it.

Navigate along the Timeline

If you have multiple clips or tracks on your Timeline, you can navigate from clip to clip or from track to track. Moving from one track to another changes the selected SpeedGrade panel. For example, moving to a grading track opens the Look panel. Moving to a pan and scan track opens the Pan & Scan panel.

<table>
<thead>
<tr>
<th>Result</th>
<th>Windows</th>
<th>Mac OS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Go the next clip</td>
<td>Ctrl+Shift+Right Arrow</td>
<td>Cmd+Shift+Right Arrow</td>
</tr>
<tr>
<td>Go to previous clip</td>
<td>Ctrl+Shift+Left Arrow</td>
<td>Cmd+Shift+Left Arrow</td>
</tr>
<tr>
<td>Go to track above</td>
<td>Ctrl+Shift+Up Arrow</td>
<td>Cmd+Shift+Up Arrow</td>
</tr>
<tr>
<td>Go to track below</td>
<td>Ctrl+Shift+Down Arrow</td>
<td>Cmd+Shift+Down Arrow</td>
</tr>
</tbody>
</table>

More Help topics

Keyboard shortcuts

Zoom the Timeline

1. Select the Master Timeline view from the view menu on the upper-left side of the Timeline.
2. Press Ctrl+Scrollwheel.

Note: Zooming works only in the Master or Playhead view of the Timeline. See Change the Timeline view.

Change the Timeline view

Set the Timeline view with the menu on the upper-left side of the Timeline.
Workspace

All  Shows all content and playheads on the Timeline.

In/Out  Shows all content between the in- and out-points.

Selected  Shows all content in the selected track.

Master  Keeps the Timeline centered on the Master playhead. On the Timeline, the playhead controller with the orange number box is the Master playhead.

Playhead  Keeps the Timeline centered on the numbered playhead. The number on the playhead controller identifies the playhead.

Delete the Timeline
Click the Delete (X) icon on the right side of the Timeline and confirm that you want to delete the Timeline.

Playback basics

Playback shortcuts
Note: Close the Desktop before playback (press D).

<table>
<thead>
<tr>
<th>Result</th>
<th>Keyboard shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Play forward</td>
<td>L</td>
</tr>
<tr>
<td>Play backward</td>
<td>J</td>
</tr>
<tr>
<td>Stop playback</td>
<td>K</td>
</tr>
<tr>
<td>Play/pause</td>
<td>Spacebar</td>
</tr>
<tr>
<td>Step forward or backward</td>
<td>Right or Left Arrow</td>
</tr>
<tr>
<td>Increase or decrease frame rate by 1 fps</td>
<td>Page Up or Page Down</td>
</tr>
<tr>
<td>Change playback mode</td>
<td>F6</td>
</tr>
</tbody>
</table>

Playback controls

Playback controls from left to right:

•  Go to in point
•  Frame step backwards
•  Play backwards
• Pause
• Play forward
• Frame step forward
• Go to out point

**Playback indicators**

The playback indicators on the left side of the Timeline provide the following information, from left to right:

• The current base frame rate
• The playback frame rate
• The disk performance indicator
• The monitor performance indicator

The disk performance indicator turns red when one of the disks or the CPU cannot deliver real-time decoding at the desired playback speed.

The monitor performance indicator turns red when one of the following issues is detected:

• An issue with the real-time performance of the grading operations you apply to the clip
• A sync issue with your display device.

**Change the base frame rate**

1 Select Settings > Playback.
2 Enter a new base frame rate.

*Note*: The Timeline timecode values reflect your base frame rate setting.

**Change the playback frame rate**

Press the Page Up or Page Down key to increase or decrease the frame rate by 1 frame per second.

**Change the playback mode**

SpeedGrade has three playback modes:

• Single run
• Ping pong
• Loop (default)

To switch modes, press F6 or use the Playback Mode button next to the playback controls.
Compare frames with multiple playheads

Use multiple playheads to compare two or more frames for color matching.

Create an additional playhead
- Hold the Control (Windows) or Command (Macintosh) key down and drag the Move Playhead icon anywhere in the Timeline.

The Move Playhead icon is the arrow icon on the right side of the playhead controller.

瞢 Make sure a green Plus (+) icon appears on the left side of the playhead controller before dropping the playhead.

Select a master playhead
When working with multiple playheads, select a master playhead to make grading and other adjustments.
- Click the playhead number to make it the master playhead.

The playhead number turns orange to indicate it is active.

Adjust the interval between playheads
- Click the Move Playhead icon and position the playhead anywhere on the Timeline.

Delete a playhead
- Click the Move Playhead icon and drag the playhead off the Timeline.

Note: Make sure the playhead is not the master one. If the number on the left of the playhead controller is orange, then it's the master playhead. Select another master playhead by clicking the playhead's number, and then delete the inactive playhead.

Work in split-screen mode
Arrange the screen layout by clicking the View button in the Timeline tab and dragging the icons in the Screen Layout panel.
Up to nine playheads can be viewed at once. When using more than nine playheads, click a number in one of the channels and select a desired playhead to view.

### Keyboard shortcuts

<table>
<thead>
<tr>
<th>Result</th>
<th>Windows</th>
<th>Mac OS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change the current split-screen mode</td>
<td>F9</td>
<td>Cmd+F9</td>
</tr>
<tr>
<td>Change the horizontal or vertical orientation of split-screen mode.</td>
<td>F10</td>
<td>Cmd+F10</td>
</tr>
<tr>
<td>Flip the channel position of the split-screen mode.</td>
<td>F11</td>
<td>Cmd+F11</td>
</tr>
</tbody>
</table>

*Note: The default F key assignments must be disabled on Mac OS systems. In System Preferences, select Keyboard, then the Keyboard Shortcuts panel. Select Expose & Spaces and deselect the default key assignments.*

### Work with projects

A SpeedGrade project is stored in XML file with an ircp filename extension. The file contains information about sequences, assets, and editing decisions.

The file stores references to the name and location of asset files in your project. If you move, rename, or delete an asset, SpeedGrade prompts you to locate the missing file the next time you open the project.

**Create your first project**

1. When creating a project from Welcome screen, save the project first.
2. Add one or more assets to the Timeline.
3. To rename the project or save it to another location, press Ctrl+S (Windows) or Cmd+S (Macintosh).

If this is not your first SpeedGrade project, see [Start a new project](#).
Start a new project

1. Delete the Timeline of an existing project.

   Deleting the Timeline unloads the current project from SpeedGrade. It does not delete the project itself.

   **Note:** Make sure to save your changes to the current project before unloading it. See Save a project.

2. Press Ctrl+S (Windows) or Cmd+S (Macintosh) to save the new blank project.

Open a project

- Press Ctrl+O (Windows) or Cmd+O (Macintosh).

  You can also click the Open SpeedGrade Project button in the toolbar on the upper-left corner of the workspace.

  ![Open SpeedGrade project](image)

  You can also open the Desktop view, navigate to the folder that contains the ircp file that you want to load, and double-click the file thumbnail.

Save a project

SpeedGrade saves the status of your work every 5 seconds. However, saving the current project from time to time is recommended. Multiple saves are useful for reverting to a previous version you liked better.

- Press Ctrl+S (Windows) or Cmd+S (Macintosh).

  You can also click the Save SpeedGrade Project button in the toolbar on the upper-left corner of the workspace.

  ![Save SpeedGrade project](image)

  You can also click the Save IRCP button on the Timeline panel.

  ![Save IRCP](image)

  **Autosave** option is now available, both in Direct Link and in native SpeedGrade mode. This option is available under References. Maximum number of versions allowed is 10.

Work on multiple projects at the same time

1. Press Ctrl+O (Windows) or Cmd+O (Macintosh) and open the first project.

2. Use the Media browser view to navigate to the folder that contains the ircp file of the second project that you want to open at the same time.

3. Click the Plus (+) icon on the file's thumbnail.
SpeedGrade opens the second project on a second Timeline. Opening multiple timelines enables split-screen playback.

**Rename a project**

1. Use the Desktop view to navigate to the folder that contains the ircp file that you want to rename.
2. Right-click the ircp file, select Rename from the context menu, and rename the file.

**Delete a project**

1. Use the Desktop view to navigate to the folder that contains the ircp file that you want to delete.
2. Right-click the ircp file and select Delete from the context menu.

**Move a project to another computer**

To move a project to another computer, move copies of all the project assets as well as the project file (ircp). Make sure that the assets retain their filenames and folder locations so that SpeedGrade can find and associate them to the project automatically.

**Set up dual displays**

You can use a dual-monitor setup to work with SpeedGrade. The SpeedGrade workspace is displayed on one monitor and the footage is displayed on the other.

**Standard dual-monitor setup**

A standard dual-monitor setup uses two monitors connected with two DVI or two DP outputs from your graphics card.

1. Connect the DVI or DP outputs to the two monitors.
   - **Tip:** Use a calibrated monitor or projector for the footage monitor.
2. In SpeedGrade, click Settings > Display and adjust the settings under Window Size.
   - The default values work for two displays with 1920x1080 resolution. SpeedGrade is displayed to the left of the display with the footage.
3. Select the Enable option.
Advanced dual-monitor setup
The advanced dual monitor setup uses nVidia Quadro SDI technology to allow for real-time 10- and 12-bit output over Single Link or Dual Link SDI. The nVidia Quadro SDI setup requires a 64-bit Windows 7 system.

1. Connect the DVI or DisplayPort output to the display you want to use for the SpeedGrade workspace.
2. Use either a Single Link or Dual Link SDI output from the NVIDIA SDI card to connect with external waveform and other monitoring devices, and your reference monitor or projector.
3. In SpeedGrade, select Settings > Display.
4. In the SDI Output section, change signal and format settings according to your desired output format settings.
5. Select the Enable option.

FAQ: How many outputs on the nVidia GPU can be used in parallel?
Only two outputs at a time can be used in parallel. The SDI card is routed through the Quadro GPU and thus takes one DVI or DP output. The other output can be used for the workspace display. The additional DisplayPort is not active in parallel.

Tip: Combining local footage display with a projection setup
To give the operator an accurate local display in parallel to another display or projection system, a signal split on the SDI output is recommended. This is the recommended way to monitor a signal through external waveform and vectorscope devices.

Direct Link workflow between Premiere Pro and SpeedGrade

About Direct Link
The Direct Link workflow is an integrated edit-and-grade workflow between Premiere Pro CC and SpeedGrade CC.
In the past, to use SpeedGrade to color grade your footage from Premiere Pro, you rendered and exported your sequences to SpeedGrade either as DPX still image sequences or edit decision lists (EDLs). After completing color grading in SpeedGrade, you exported the projects as stand-alone video files back into Premiere Pro for more editing.
Direct Link offers a fast and efficient alternative to this workflow. Leveraging the power of the Mercury Playback Engine, Direct Link lets you send or open Premiere Pro projects directly in SpeedGrade. You can color grade Premiere Pro sequences in SpeedGrade and send it back to Premiere Pro in a few clicks.

To achieve optimal performance when using Direct Link, use an NVIDIA CUDA graphics card with GPU acceleration on Windows. For more information about Adobe-certified NVIDIA graphics cards, see the Tech specs.

Edit and grade Premiere Pro sequences with Direct Link
The Direct Link workflow lets you roundtrip Premiere Pro projects between editing and grading without time-consuming or complex tasks like rendering and conforming.
Step 1: Select Premiere Pro sequence
Select the Premiere Pro sequence that you want to color grade.

*Note:* Ensure that you have selected the sequence in the Timeline or Project panel.

Step 2: Send sequence to SpeedGrade using Direct Link
Using Direct Link, you can send a sequence from an open Premiere Pro project directly to SpeedGrade without exporting the project.

To use Direct Link, select File > Direct Link To Adobe SpeedGrade.

Step 3: Choose to open sequence in SpeedGrade
When you select the Direct Link workflow, Premiere Pro prompts you to save changes to the project in Premiere Pro and open it in SpeedGrade. Click Yes.

Step 4: Selected sequence opens in SpeedGrade
Premiere Pro closes, and SpeedGrade opens the sequence in its Timeline, which uses the same familiar track layout as Premiere Pro.

In the SpeedGrade Timeline, you can see all the clip edit points, transitions, and layers.
Step 5: Color grade the sequence using grading and mask tools

Within SpeedGrade, you can color grade the sequence using Looks and Masks. The Looks that you apply in SpeedGrade will appear as Lumetri presets when you reopen the sequence in Premiere Pro.

If a Lumetri Look has already been applied in Premiere Pro, it’s available in the SpeedGrade Timeline, where you can adjust its parameters.

The Direct Link workflow has been designed to let you focus on the color correction and grading tasks when you are in SpeedGrade. Because of this focus, only the Color and Look tabs in SpeedGrade are available in the Direct Link mode. For more details, see Direct Link workflow limitations.

Step 6: Send the color graded sequence to Premiere Pro for editing

When you finish color grading your sequence in SpeedGrade, save and reopen the sequence in Premiere Pro for final output or further editing.

Click the Direct Link to Adobe Premiere Pro icon in the upper left of the SpeedGrade user interface.

The color graded sequence opens in Premiere Pro with all color grading fully intact.

Color grading and masks applied in SpeedGrade are visible in Premiere Pro as Lumetri effects. In Premiere Pro, you can turn these Lumetri effects on or off for each clip and for each adjustment layer individually using the Effects Controls panel.

You continue editing or export your sequence for final output in Premiere Pro.
Open Premiere Pro projects directly in SpeedGrade

You can open native Premiere Pro projects directly in SpeedGrade, apply color grading changes, and reopen the project in Premiere Pro.

The SpeedGrade Welcome screen lets you:

- Open a recently accessed Premiere Pro project (.pproj)
- Open a Premiere Pro project (.pproj)
- Create a new SpeedGrade project (.IRCP)

When you open a Premiere Pro project, the Sequence Importer dialog opens showing all the sequences contained in the project. Select a sequence to open.

**Note:** SpeedGrade cannot open more than one Premiere Pro sequence at the same time.

Within SpeedGrade, you can apply primary and secondary color correction, apply Looks and Masks, and do all the required color grading.

**Note:** You cannot send SpeedGrade (.IRCP) projects back to Premiere Pro. To use Direct Link you need to start with a Premiere Pro project (.pproj).

Some important points:

- From within SpeedGrade, you can view and adjust Premiere Pro adjustment layers, and also view any transitions applied to the sequence.
- All the color grading that you apply in SpeedGrade is available automatically in Premiere Pro. There is no need to export the .look files.

Working with offline media

When you open a Premiere Pro project with missing media files in SpeedGrade, you cannot link and locate the offline media like you would in Premiere Pro.

To relink the offline media, you must bring the the project back to Premiere Pro.

Working with After Effects Compositions

There are several ways to use After Effects Compositions in your Premiere Pro project:

- Replace a clip in Premiere Pro with an After Effects Composition
- Link to an After Effects Composition using Adobe Dynamic Link
- Import an After Effects Composition (AEP file) into a Premiere Pro project

Irrespective of which method you use, you can open a Premiere Pro sequence containing After Effects Compositions directly in SpeedGrade. SpeedGrade opens the sequence in Direct Link mode, from where you can color grade the compositions just as you would color grade any Premiere Pro sequence.
Limitations in Direct Link mode

The Direct Link workflow has been designed such that you focus only on the color correction and grading workflows within SpeedGrade.

Given this focus, there are specific things to consider while using SpeedGrade in the Direct Link mode:

• The auto-save feature is turned off while using the Direct Link mode.
• To use Direct Link, you start with a Premiere Pro project (.pproj). You cannot send SpeedGrade projects (.IRCP) to Premiere Pro in the Direct Link mode.
• In the Direct Link mode, you cannot render your Premiere Pro projects within SpeedGrade. You send the projects back to Premiere Pro for rendering. So, the Render and Results tabs are unavailable when using Direct Link.
• SpeedGrade can open only one Premiere Pro sequence at a time, and not multiple sequences at once. To open a different sequence in the project, open the Sequence Importer dialog by clicking in the SpeedGrade Timeline.
• You cannot launch the Media Browser to browse through media, so the Media tab is unavailable when using Direct Link.
• You cannot add clips to the Premiere Pro sequence within SpeedGrade. You have to bring the project back to Premiere Pro to edit the sequence.
• You cannot adjust audio or use the Pan & Scan functions. So, Stereo 3D, Audio, and Pan And Scan tabs are unavailable when using Direct Link.
• If you apply the Warp Stabilizer effect on a Premiere Pro sequence, ensure that the analysis is complete before sending the sequence to SpeedGrade using Direct Link. Otherwise, an error message appears.

Video tutorial

How to make your video look like film

Learn how to use Direct Link to roundtrip your projects to SpeedGrade for comprehensive color grading and applying preset film stock and camera looks.

Image analysis tools

SpeedGrade provides various tools, like the following, to analyze your image:

• Histogram
• Vectorscope
• RGB Parade
• Luma Waveform

These tools are now grouped together and available from the Analysis Tools panel.

To display the Analysis Tools panel, use the keyboard shortcut A, or click the arrow on the upper-left Monitor panel. You can adjust the size of the Analysis Tools panel using the drag handles.

Use the context menu to choose which video scope you want to view.
### Histogram

Histogram shows RGB values. The minimum Luma values per channel are displayed as numerical feedback at the bottom. Maximum values are displayed at the top. Two horizontal lines indicate the output range. The default range is set to CIN code values (95 - 685).

### Vectorscope

The Vectorscope displays the video's chrominance information in a circular chart. Saturation is measured from the center of the chart outward.

Vectorscopes work in YUV and HLS (Hue, Lightness, Saturation) modes. The YUV Vectorscope uses the more familiar YUV color space including color targets to display the pixel distribution in your images more intuitively. The YUV vectorscope is the default option.
RGB Parade

RGB Parade scope displays separate waveforms for the red, green, and blue components of an image. The waveforms are displayed side by side, making it easy to compare the relative levels of reds, greens, and blues in an image, and make adjustments as required. The RGB Parade scope also makes it easy to spot color casts in your image.

Luma Waveform

The Luma Waveform scope displays a representation of the luminance of your images, similar to how it is displayed in Premiere Pro.

High luma levels appear as spikes on the waveform, and low luma levels appear as dips. This scope lets you quickly identify highlights and shadows in your image, helping you achieve precise black-and-white balancing.
Channel views

Use channel views to check specific color channels. For example, you can use it to check for compression artifacts or noise in the RGB channels.

To see a channel on the Monitor, follow these steps:

1. Select the Timeline tab, and then select View.
2. Select a channel from the Channel View menu under Display Options.

For example, if your image includes an alpha channel, select Alpha Channel to view on the Monitor. To switch back to normal view, select the channel view as Normal View.

Work with keyframes

Use keyframes to transform the state of a grade, mask, or pan-and-scan adjustment over time. A keyframe marks the point in time where you specify a state, such as the position of a mask. You typically use at least two keyframes—one for the state at the beginning of the change, and one for the new state at the end of the change. You can add as many keyframes as you need on a track. SpeedGrade interpolates the values between keyframes and creates dissolves between them.
Add keyframes

Every new grading track has one keyframe at its start position. If you don’t add more keyframes, any adjustments affect the whole clip.

To add more keyframes along a track:

1 Move the playhead to the position you’d like to add a keyframe.
2 Click the Record Keyframe button.
3 Apply adjustments at the new keyframe position, such as a grade, mask, or pan-and-scan adjustment.
4 With the playhead at the current keyframe, click the Record Keyframe button a second time to create a dissolve from the previous keyframe to the current keyframe. See Workflow for creating dissolves between keyframes.

An arrow between the keyframes on the track indicates a linear dissolve between the two positions.

Workflow for creating dissolves between keyframes

Create a dissolve between two keyframes by clicking the Record Keyframe button a second time at each new keyframe position. The typical workflow is as follows:

1 Move the playhead to the position on the timeline where you want to start the dissolve.
2 Add a keyframe by clicking Record Keyframe.
3 Move to the playhead to the position on the timeline where you want to end the dissolve.
4 Click on Record Keyframe twice to add a keyframe that will smoothly morph all settings from the previous to the current keyframe.
5 Adjust your grade, mask, or pan-and-scan at the two keyframe positions.

Automatically record keyframes when editing

When Auto-keyframe mode is on, modifying a property automatically adds a keyframe at each new position.

❖ Click the Auto-keyframe button to toggle Auto-keyframe mode on or off.
Move between keyframes
❖ Press the left or right arrow buttons on the keyframe toolbar.

Tip: You can also use the following keyboard shortcut: Ctrl+Shift+Left/Right Arrow.

Delete keyframes
To delete one keyframe:
1 Navigate to the keyframe you want to remove.
2 Click the delete keyframe button.

Other keyframes on the same track are not affected.

To delete all keyframes on a track:
❖ Click the Delete All Keyframes button.

Keyframes on other grading, mask, or pan-and-scan tracks above or below the current grading clip are not affected.

Related topics
• Quickstart: Color grade a clip
• Track a masked object through a shot
• Adjust the framing of shots with pan and scan

Adjust the display aspect ratio
You can correctly display anamorphic and other non-square-pixel aspect ratio footage in the Monitor by changing the display aspect ratio.

Note: Changing the display aspect ratio does not modify the source material.

1 With a clip on the Timeline, click the View button on the Timeline panel.

2 In the Display Options section, click the icon on the left side of the Aspect Ratio menu.
The button toggles the Aspect Ratio menu.

3 Change the display aspect ratio by selecting an option from the menu.
4 To switch to the default aspect ratio, click the icon again.

More Help topics
Crop the display frame

Crop the display frame

You can set the display size of your frames by cropping them in the monitor.

Cropping frames in the monitor does not modify the source material. Instead, the frame hides parts of the image. Color corrections are still applied to the parts of the image hidden by the frame.

If you want to resize the display frame and keep the entire image in the frame, see Adjust the display aspect ratio.

1 With a clip on the Timeline, click the View button on the Timeline panel.

2 In the Display Options section, click the icon on the left side of the Crop menu.

   The button toggles the Crop menu.

3 Select a crop preset from the menu.
4 To turn off the crop preset, click the icon again.

Adjust the display resolution for playback

SpeedGrade dynamically adjusts the quality of video to ensure smooth playback on computers with less capable graphic cards or CPUs. To optimize performance, you can set the quality settings for the image both during playback and when paused.
Test the performance of your system during playback and then adjust the settings accordingly.

1. Click the Settings menu on the upper-right corner of the screen, and then select the Dynamic Quality option.

2. Select a lower resolution for playback, such as 1:2 (half the resolution of the source material) or lower.

3. Set the resolution for paused images.

   Note: Use the paused image resolution to see more image detail. Set it as high or higher than the selected playback resolution.

4. If working with formats that have a native color depth greater than 8 bits per channel, you can set the color depth for playback and paused images as well.

---

**Keyboard shortcuts**

Print a PDF of the keyboard shortcuts

The keyboard shortcuts for SpeedGrade CC are available as a downloadable PDF from here.

For the F-key shortcuts to work on Mac systems, press the fn key and then the F-key. For example, to use the F1 shortcut, press fn+F1.

**Application shortcuts**

<table>
<thead>
<tr>
<th>Result</th>
<th>Windows</th>
<th>Mac OS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Help</td>
<td>F1</td>
<td>F1</td>
</tr>
<tr>
<td>Show or hide grading panels</td>
<td>P</td>
<td>P</td>
</tr>
<tr>
<td>Show or hide Settings window</td>
<td>S</td>
<td>S</td>
</tr>
<tr>
<td>Show Desktop</td>
<td>D</td>
<td>D</td>
</tr>
</tbody>
</table>
## Workspace

<table>
<thead>
<tr>
<th>Action</th>
<th>Windows</th>
<th>Mac OS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save Timeline</td>
<td>Ctrl+S</td>
<td>Cmd+S</td>
</tr>
<tr>
<td>Show or hide Render window</td>
<td>Ctrl+R</td>
<td>Cmd+R</td>
</tr>
<tr>
<td>Show History panel</td>
<td>Ctrl+H</td>
<td>Cmd+H</td>
</tr>
<tr>
<td>Toggle Fullscreen mode</td>
<td>Alt+Enter or F</td>
<td>F</td>
</tr>
<tr>
<td>Toggle Image-only mode</td>
<td>Shift+H</td>
<td>Shift+H</td>
</tr>
<tr>
<td>Escape Image-only mode</td>
<td>Esc</td>
<td>Esc</td>
</tr>
<tr>
<td>Show or hide Metadata display</td>
<td>M</td>
<td>M</td>
</tr>
<tr>
<td>Toggle mouse between main and SDI display</td>
<td>Shift+X</td>
<td>Shift+X</td>
</tr>
<tr>
<td>Reconnect CP200 panels</td>
<td>Alt+F12</td>
<td>Alt+F12</td>
</tr>
<tr>
<td>Show or hide Dual DVI window (toggle)</td>
<td>Shift+Ctrl+Alt+D</td>
<td>Shift+Ctrl+Alt+D</td>
</tr>
<tr>
<td>Show the Reel browser</td>
<td>Ctrl+Alt+R</td>
<td>Cmd+Alt+R</td>
</tr>
<tr>
<td>Close Preferences window</td>
<td>Esc</td>
<td>Esc</td>
</tr>
<tr>
<td>Close application</td>
<td>Alt+F4</td>
<td>Cmd+Q</td>
</tr>
</tbody>
</table>

### Playback shortcuts

<table>
<thead>
<tr>
<th>Result</th>
<th>Windows</th>
<th>Mac OS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Play/Pause</td>
<td>[space]</td>
<td>[space]</td>
</tr>
<tr>
<td>Reverse playback</td>
<td>Shift+{space}</td>
<td>Shift+{space}</td>
</tr>
<tr>
<td>Step back one frame</td>
<td>Left Arrow</td>
<td>Left Arrow</td>
</tr>
<tr>
<td>Step forward one frame</td>
<td>Right Arrow</td>
<td>Right Arrow</td>
</tr>
<tr>
<td>Decrease playback FPS</td>
<td>PgDn</td>
<td>PgDn</td>
</tr>
<tr>
<td>Increase playback FPS</td>
<td>PgUp</td>
<td>PgUp</td>
</tr>
<tr>
<td>Double frames per second</td>
<td>Numpad *</td>
<td>Numpad *</td>
</tr>
<tr>
<td>Halve frames per second</td>
<td>Numpad /</td>
<td>Numpad /</td>
</tr>
<tr>
<td>Switch between single play, loop, and ping-pong playback mode</td>
<td>F6</td>
<td>F6</td>
</tr>
<tr>
<td>Mirror image horizontally</td>
<td>Alt+M</td>
<td>Alt+M</td>
</tr>
<tr>
<td>Mirror image vertically</td>
<td>Shift+M</td>
<td>Shift+M</td>
</tr>
<tr>
<td>Clear memory (unload all frames)</td>
<td>Shift+Ctrl+F5</td>
<td>Shift+Cmd+F5</td>
</tr>
<tr>
<td>Reload changed frames from disk</td>
<td>F5</td>
<td>F5</td>
</tr>
<tr>
<td>Playback forward</td>
<td>L</td>
<td>L</td>
</tr>
<tr>
<td>Playback backward</td>
<td>J</td>
<td>J</td>
</tr>
<tr>
<td>Stop</td>
<td>K</td>
<td>K</td>
</tr>
</tbody>
</table>
# Keyframe shortcuts

<table>
<thead>
<tr>
<th>Result</th>
<th>Windows/Mac OS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add a keyframe</td>
<td>F2</td>
</tr>
<tr>
<td>Remove a keyframe</td>
<td>Shift+F2</td>
</tr>
<tr>
<td>Go to the previous keyframe</td>
<td>F3</td>
</tr>
<tr>
<td>Go to the next keyframe</td>
<td>F4</td>
</tr>
</tbody>
</table>

# Pan and zoom view shortcuts

<table>
<thead>
<tr>
<th>Result</th>
<th>Windows</th>
<th>Mac OS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pan up/down</td>
<td>Shift+Up/Down Arrow</td>
<td>Shift+Up/Down Arrow</td>
</tr>
<tr>
<td>Pan left/right</td>
<td>Shift+Left/Right Arrow</td>
<td>Shift+Left/Right Arrow</td>
</tr>
<tr>
<td>Reset pan</td>
<td>Shift+Home</td>
<td>Shift+Home</td>
</tr>
<tr>
<td>Match channel sizes</td>
<td>Alt+Home</td>
<td>Alt+Home</td>
</tr>
<tr>
<td>Zoom in/out</td>
<td>Numpad +/-</td>
<td>Numpad +/-</td>
</tr>
<tr>
<td>Zoom to 100%</td>
<td>Shift+Ctrl+Home</td>
<td>Shift+Cmd+Home</td>
</tr>
<tr>
<td>Zoom to fit</td>
<td>Ctrl+Home</td>
<td>Cmd+Home</td>
</tr>
</tbody>
</table>

# Splitscreen view shortcuts

<table>
<thead>
<tr>
<th>Result</th>
<th>Windows</th>
<th>Mac OS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change the splitscreen mode</td>
<td>F9</td>
<td>Cmd+F9</td>
</tr>
<tr>
<td>Change the vertical/horizontal orientation of the split screen</td>
<td>F10</td>
<td>Cmd+F10</td>
</tr>
<tr>
<td>Switch the channel positions in the split screen</td>
<td>F11</td>
<td>Cmd+F11</td>
</tr>
</tbody>
</table>

# Timeline and navigation shortcuts

<table>
<thead>
<tr>
<th>Result</th>
<th>Windows</th>
<th>Mac OS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Next/previous clip</td>
<td>Ctrl+Right/Left Arrow</td>
<td>Cmd+Right/Left Arrow</td>
</tr>
<tr>
<td>Select previous clip</td>
<td>Shift+Ctrl+Left Arrow</td>
<td>Shift+Cmd+Left Arrow</td>
</tr>
<tr>
<td>Select next clip</td>
<td>Shift+Ctrl+Right Arrow</td>
<td>Shift+Cmd+Right Arrow</td>
</tr>
<tr>
<td>Select clip below</td>
<td>Shift+Ctrl+Down Arrow</td>
<td>Shift+Cmd+Down Arrow</td>
</tr>
<tr>
<td>Select clip above</td>
<td>Shift+Ctrl+Up Arrow</td>
<td>Shift+Cmd+Up Arrow</td>
</tr>
<tr>
<td>Center master playhead</td>
<td>Ctrl+Numpad 0</td>
<td>Ctrl+Numpad 0</td>
</tr>
<tr>
<td>Move master playhead to selected clip</td>
<td>Alt+Numpad 0</td>
<td>Alt+Numpad 0</td>
</tr>
</tbody>
</table>
### In- and out-point shortcuts

<table>
<thead>
<tr>
<th>Result</th>
<th>Windows, Mac OS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set in-point at current master playhead position</td>
<td>I</td>
</tr>
<tr>
<td>Set out-point at current master playhead position</td>
<td>O</td>
</tr>
<tr>
<td>Move master playhead to current in-point</td>
<td>Home</td>
</tr>
<tr>
<td>Move master playhead to current out-point</td>
<td>End</td>
</tr>
<tr>
<td>Reset in- and out-points to default positions</td>
<td>Shift+Ctrl+Alt+O</td>
</tr>
<tr>
<td>Toggle In/Out point settings between current clip and Home/End of timeline</td>
<td>Ctrl+[space]</td>
</tr>
<tr>
<td>Reload replaced frames on disk</td>
<td>Shift+F5</td>
</tr>
</tbody>
</table>

### Grading shortcuts

<table>
<thead>
<tr>
<th>Result</th>
<th>Windows</th>
<th>Mac OS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Toggle grading on/off</td>
<td>0 (zero)</td>
<td>0 (zero)</td>
</tr>
<tr>
<td>Apply previewed preset to the timeline</td>
<td>Enter</td>
<td>Enter</td>
</tr>
<tr>
<td>Reject previewed preset</td>
<td>Backspace</td>
<td>Backspace</td>
</tr>
<tr>
<td>Change color selector mode</td>
<td>Shift+Enter</td>
<td>Shift+Enter</td>
</tr>
<tr>
<td>Reset grading on current clip</td>
<td>Shift+Alt+Delete</td>
<td>Shift+Alt+Delete</td>
</tr>
<tr>
<td>Reset grading on current panel</td>
<td>Alt+Delete</td>
<td>Alt+Delete</td>
</tr>
<tr>
<td>Copy grade from the previous or next 9 edits</td>
<td>[Numpad]1 to 9</td>
<td>[Numpad]1 to 9</td>
</tr>
<tr>
<td>Set the Copy Grade Feature to copy from next edits</td>
<td>Alt+{Numpad} +</td>
<td>Alt+{Numpad} +</td>
</tr>
<tr>
<td>Set the Copy Grade Feature to copy from previous edits</td>
<td>Alt+{Numpad} -</td>
<td>Alt+{Numpad} -</td>
</tr>
<tr>
<td>Copy grade from clip below mouse position</td>
<td>C</td>
<td>C</td>
</tr>
<tr>
<td>Disable grading (hold down) in selected layer</td>
<td>. (period)</td>
<td>. (period)</td>
</tr>
<tr>
<td>Navigate layer stack up/down</td>
<td>Ctrl+Up/Down Arrow</td>
<td>Cmd+Up/Down Arrow</td>
</tr>
</tbody>
</table>

### Look browser, Snapshot browser shortcuts

<table>
<thead>
<tr>
<th>Result</th>
<th>Windows</th>
<th>Mac OS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Look Browser navigation</td>
<td>Alt+Left/Right/Up/Down Arrow</td>
<td>Alt+Left/Right/Up/Down Arrow</td>
</tr>
<tr>
<td>Toggle Looks Management Browser on/off</td>
<td>Ctrl+L</td>
<td>Cmd+L</td>
</tr>
<tr>
<td>Snapshot Browser navigation</td>
<td>Shift+Alt+Left/Right/Up/Down Arrow</td>
<td>Shift+Alt+Left/Right/Up/Down Arrow</td>
</tr>
<tr>
<td>Add or toggle snapshot</td>
<td>Shift+C</td>
<td>Shift+C</td>
</tr>
<tr>
<td>Collapse third panel in Snapshot Browser</td>
<td>W</td>
<td>W</td>
</tr>
</tbody>
</table>
## Continuity Checker, Automatic Shot Match shortcuts

<table>
<thead>
<tr>
<th>Result</th>
<th>Windows</th>
<th>Mac OS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add one or more playheads while using the Continuity Checker</td>
<td>Alt+1/2/3</td>
<td>Option+1/2/3</td>
</tr>
<tr>
<td>Use the Auto Shot Match feature</td>
<td>Ctrl+M</td>
<td>Cmd+M</td>
</tr>
</tbody>
</table>

## Gray-out shortcuts

<table>
<thead>
<tr>
<th>Result</th>
<th>Windows</th>
<th>Mac OS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Turn on gray-out</td>
<td>Ctrl+G</td>
<td>Cmd+Shift+G</td>
</tr>
<tr>
<td>Turn on black-out</td>
<td>Alt+G</td>
<td>Alt+G</td>
</tr>
<tr>
<td>Turn on white-out</td>
<td>Ctrl+Alt+G</td>
<td>Cmd+Alt+G</td>
</tr>
<tr>
<td>Turn off gray-out</td>
<td>Shift+Alt+G</td>
<td>Shift+Alt+G</td>
</tr>
</tbody>
</table>

## Editorial shortcuts

<table>
<thead>
<tr>
<th>Result</th>
<th>Windows</th>
<th>Mac OS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Toggle selected dissolve clip's direction (bottom-to-top/top-to-bottom)</td>
<td>Shift+D</td>
<td>Shift+D</td>
</tr>
<tr>
<td>Split currently active clip and all clips directly above it at the master playhead position</td>
<td>Shift+Alt+S</td>
<td>Shift+Alt+S</td>
</tr>
<tr>
<td>Splits currently active clip at the master playhead position</td>
<td>Ctrl+Alt+S</td>
<td>Cmd+Alt+S</td>
</tr>
</tbody>
</table>

## Analysis tools shortcuts

<table>
<thead>
<tr>
<th>Result</th>
<th>Windows, Mac OS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Analysis Tools panel</td>
<td>A</td>
</tr>
</tbody>
</table>

## Channel view shortcuts

<table>
<thead>
<tr>
<th>Result</th>
<th>Windows, Mac OS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show red channel</td>
<td>R</td>
</tr>
<tr>
<td>Show green channel</td>
<td>G</td>
</tr>
<tr>
<td>Show blue channel</td>
<td>B</td>
</tr>
<tr>
<td>Hide red channel</td>
<td>Shift+R</td>
</tr>
<tr>
<td>Hide green channel</td>
<td>Shift+G</td>
</tr>
<tr>
<td>Hide blue channel</td>
<td>Shift+B</td>
</tr>
</tbody>
</table>
## Stereoscopic viewing shortcuts

<table>
<thead>
<tr>
<th>Result</th>
<th>Windows, Mac OS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Right eye</td>
<td>Left Alt+R</td>
</tr>
<tr>
<td>Left eye</td>
<td>Left Alt+L</td>
</tr>
</tbody>
</table>
Chapter 3: Loading footage

Supported file formats

Frame sequence formats

<table>
<thead>
<tr>
<th>Format</th>
<th>Read</th>
<th>Write</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cineon</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>DPX, DPX 2.0</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Targa</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>JPEG</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>PNG</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>TIFF</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Pixarlog TIFF</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Floating Point TIFF</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Maya IFF</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Lightwave IFF</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>RGB (SGI)</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Softimage PIC</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Wavefront RLA</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Wavefront RPF</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Windows Bitmap</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>GIF</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Cinema DNG</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>OpenEXR</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Movie file formats

<table>
<thead>
<tr>
<th>Format</th>
<th>Read</th>
<th>Write</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows AVI</td>
<td>Windows only</td>
<td>Windows only</td>
</tr>
<tr>
<td>Quicktime</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>
**RAW file formats**
The supported RAW formats are read-only.

- ARRI Alexa .ari
- ARRI D21 .ari
- Phantom HD / GOLD / FLEX / 65 (.cine)
- REDCode RAW (.r3d)
- Silicon Imaging SI 2K/SI Mini (Uncompressed .siv)
- Weisscam HS-1/HS-2 RAW (.wcr)
- Weisscam HS-2 Digimag (.fhg*)

**Load footage**

**Load items**
Add items to the Timeline as follows.

- Navigate to the item in Desktop view, then double-click the thumbnail. You can also drag an item to the Timeline.
- Repeat the process to add more items. Each item is placed after the last item on the Timeline.

**More Help topics**

- Supported file formats
- Navigate to a folder
- Desktop basics
- Timeline basics

**Load multiple items at once**
Loading multiple items at once is useful when loading RAW data for creating dailies to create a virtual lab reel.

1. In Desktop view, browse to the folder with the items you want to add to the Timeline.
2. Click Add All on the lower-right side of the Desktop.

![Add All button](image)

SpeedGrade adds all the files to the Timeline in order of appearance.

**Insert items between clips**

1. Drag the thumbnail from the Desktop view to the position on the Timeline where you’d like to place it.
2. When a highlighted red line appears at the desired location, release the mouse button.

Last updated 12/10/2014
**Conform EDLs**

Edit Decision Lists (EDLs) are metadata documents used to migrate project timelines from other editing tools.

Timelines created from EDLs in SpeedGrade adhere to the Sony CMX 3600 standard. SpeedGrade also supports the extended 16-digit EDL to work with ARRIRAW and Red R3D material.

The two most common scenarios for conforming EDLs are as follows:

- You have an EDL and one long image sequence or movie file with all the edits baked in. You want to use the EDL to create keyframes to cut the clip into individual edits. See Master-clip workflow.
- You have an EDL with online material in several folders or consisting of individual movie files. You want to associate the correct online clips according to the Reel ID/filename information available in the EDL. See Multiple-clip workflow.

*Note:* Before working with EDLs, make sure to set the correct frame rate preset in SpeedGrade. For example, if your project is based on 24 fps, set both your preset for new timelines and your base fps to 24. For instructions, see Playback basics.

**Master-clip workflow**

Follow this workflow if you have one long clip of online material and want to use an EDL to cut it into individual edits.

1. Locate the pre-conformed clip in the Desktop view and drop it on the Timeline.
2. Locate the EDL in the Desktop view and drop it on the clip in the Timeline.
   SpeedGrade cuts the clip into edits.

**Multiple-clip workflow**

1. Locate the EDL in the Desktop view and drop it on the Timeline.
   SpeedGrade inserts placeholder clips on the Timeline representing all the edits. The clips are red because the reels are not loaded yet.
2. Use the Desktop to locate the footage that represents the reels.
   Use the filter options to search subfolders or to treat folders as reels. For example, if all the material is in one folder structure, select the Sequences from Folder + Subtree filter option.
3. Click Load from Desktop to connect the source clips to the placeholder clips.

   To prevent reels on the Timeline from being replaced when adding new reels from other locations, select the Don’t Replace Loaded Reels checkbox.
4. If your material is in several folders, repeat the process with the other folders.
About footage references
An EDL can reference footage with a clip name and reel ID. If the reel ID information is not present, SpeedGrade can use the clip name. If both are present, SpeedGrade references the reel ID first.

Sometimes, the reel ID and clip name information don’t match and the footage can’t be associated automatically. In this case, you can drop material manually from the Desktop on the placeholder reels.

Dissolves
Dissolves between clips according to an EDL are available as A and B layer with a dissolve layer in between. All three layers are generated automatically when conforming an EDL.

Supported EDL features
Reel ID The CMX reel ID is the primary means of identification for a clip. If possible, place reel footage in subfolders with the Reel ID provided in the 3600 EDL.

CLIP NAME SpeedGrade supports the FROM CLIP NAME syntax in a CMX comment. Clip name is the secondary means of identification for a clip. If the Reel ID provided is not found or the Reel ID is AX, the clip name is used.

Replacements The syntax REEL AX IS CLIP is supported.

FLIPS AND FLOPS Vertical and horizontal mirroring is supported. The FLIP, FLOP, and FLIP-FLOP comment keywords are evaluated.

M2 (Time Warp) M2 speed change/time warp commands are supported. Reverse playback is supported.

K (Key) Key commands are not supported and result in an error at load time.

Loading and conforming material

Load audio tracks
1 Open the Desktop view and browse to an audio file (wav or aiff file).
2 Drag the file on the Timeline.
   Green tracks represent audio clips.
3 Adjust the position of the audio clip along the Timeline.
4 Enable and disable the audio of a selected track by clicking the speaker icon on the left side of the Timeline.
To change values for sound output, such as the mixing frequency, select Settings > Sound. The Settings menu is on the upper-right corner of the SpeedGrade workspace.

Detect scene changes

You can automatically detect scene changes in footage that does not have an EDL, such as archived material. Once SpeedGrade has identified scene changes, you can add keyframes to scene changes, or split your footage up into separate clips.

The workflow consists of the following steps:

1. Detect the scene changes.
2. Prepare the footage for grading or editing.
3. Save or export the footage.

Detect scene changes

1. Select your footage on the Timeline.
2. Click the Timeline tab and select the Setup panel.
   The Scene Change Detect dialog box opens and SpeedGrade automatically scans your footage for scene changes.

4. When the scan is complete, you can review the results using the arrow buttons on the left side of the dialog box.
   • Step through frames to review the content.
   • To confirm scene changes, select the This Frame is a Scene Change checkbox.
   • Use the checkbox to add scene changes.

5. If necessary, you can adjust scene detection sensitivity and click Rescan Clip.

Prepare the footage for grading or editing

After marking your scene changes, prepare the footage for grading or editing as follows:

• To separate the footage into individual shots or scenes, click Split into Clips.
• To flag the scene changes, click Add Keyframes to Clip.
Save or export the footage

Once you split into clips or add keyframes, you can save the scene-detected content as a SpeedGrade project or create an Edit Decision List (EDL).

In the Setup Panel under the Timeline tab, do one of the following:

- To save the content as a SpeedGrade project, click Save IRCP.
- To export an Edit Decision List, click Save EDL.

Using scene change detection

Display burn-in information on frames

You can "burn" (overlay) metadata information on your frames during playback or on the rendered output. For example, selecting the Standard burn-in preset in SpeedGrade superimposes the following information on the footage:

- Current frame number
- Location on disk of current sequence
- Native time code of current frame (assuming the information exists in the header of the file format you’re using)

Display burn-in information during playback

1 In the Timeline tab, select the View pane.
2 Under Display Options, select a burn-in preset from the Burn In menu.

Note: If the menu is inactive, click the Burn-in tool to make it active.

Display burn-in information on the rendered output

Including burn-in information on rendered output can be useful when creating proxy media for offline editing or dailies for review.

- When setting the rendering options in the Output panel, select a burn-in preset from the menu.
- In the Flash Burn-In For text box, set the number of frames to display the burn-in information. The default setting is 0, meaning burn-in information is included on all rendered frames.
Chapter 4: Color grading

Quickstart: Color grade a clip

To load an EDL and color grade a sequence, see Quickstart: Color grade a sequence.

Select a clip
1 In SpeedGrade, select a folder that contains video clips using the file browser in the upper-left corner of the user interface.

The Desktop window shows thumbnail versions of the content in the selected folder.

To filter the thumbnails by file type, select All Files in the upper-right corner and then select a file type.

2 Place a clip on the Timeline by double-clicking it on the Desktop.

3 Click the Monitor Tab in the upper-left corner to view the image.

The default display size is 100%. To fit the image in the monitor window, click the Zoom to Fit button below the scopes window on the right side of the interface.

Apply a primary color grade

Make basic color changes like temperature, white point, black point, and more, to the entire image. The changes are applied to a primary grading layer.

Access the grading controls by clicking the Look tab in the lower left, below the timeline.

Make global changes

Make global changes to the image with the sliders at the top of the Look panel.

To adjust a global setting, do the following:

1 Right-click the triangle icon on the slider and release the click button.
2 Swipe the mouse left or right to change the value.
3 Right-click the triangle icon again to accept the setting.

**Make changes to specific regions**
Modify color and luminance values in the image’s shadow, midtone, and highlight regions using the color control wheels on the Look panel.

![Color control wheels](image)

To adjust the luminance, do the following:

- Left-click the triangle icon on a wheel and drag the mouse left or right in a straight line. Don’t drag the mouse in a circle. The further left or right you drag, the larger the change.

To adjust the color, do the following:
1 Right-click inside the circle and release the click button.
2 Swipe the mouse in any direction to change the value.
3 Right-click again to accept the setting.

You can use color sliders instead of control wheels. To access the sliders, press Shift+Enter.

![Color sliders](image)

*Use the zero (0) key on the numeric keypad to toggle the grade on and off for a quick before and after view. Make sure the NumLock key on your keyboard is selected.*

**Apply a secondary color grade**
Make targeted adjustments to a specific hue range in the image. The changes are applied to a secondary grading layer.

1 Access the secondary color grading tools by selecting the +S icon in the lower-left corner of the Layers window.

![Secondary color grading tools](image)

2 Select a hue range as follows:
   - Select a preset hue option by clicking one of the colored buttons along the top of the Hue selection tool.
   - Sample a hue range by clicking the eyedropper tool with the + icon and then dragging to select a portion of the image in the Monitor window.

*You may have to resize the lower border of the Desktop window to see the eyedropper tools. To resize the window, use the drag resize tool located at the bottom center of the Timeline.*
3 View the portion of the image targeted by the hue range selection by selecting an option from the Gray-out menu at upper-right corner of the Look tab.

4 Make adjustments and refinements to the selection using the upper triangles of the sliders. Use the lower triangles of the sliders to adjust fall-off.

5 Make secondary corrections with the Off-set and Gain control wheels in the center of the Look window.

6 Soften and blend secondary corrections using the Denoise and Blur sliders on the right of the Look window.

7 After making secondary corrections, set Gray-out to None.

**Render a graded clip**

1 Click the Output tab in the upper-right corner to open the Metadata Render Engine.

2 Click the Desktop menu and select a destination folder.

3 Assign a name to the rendered file in the File Name textbox.

4 In Format & Options, select a output file format for the render.
   If a desired preset doesn't exist, create a new one by clicking Other.

5 Click Online Quality in the Render section.

6 Click Render.

**Quickstart: Color grade a sequence**

The workflow for color grading a sequence consists of the following steps:

**Load an EDL**

Edit Decision Lists (EDLs) are metadata documents used to migrate project timelines from editing tools like Adobe Premiere Pro to post-production tools like SpeedGrade.
Color grading

Tip: Before starting, place the source clips and the EDL file in a single folder. This organization makes the process quicker and more efficient.

1 In SpeedGrade, select the folder containing the EDL file with the file browser in the upper-left corner of the user interface.
2 Double-click the EDL file to load it.
   Tip: If you have too many thumbnails, you can filter them for EDL files by selecting the EDL option from the All Files menu in the upper-right corner.

SpeedGrade places placeholder thumbnails in the video track and in the Reels panel. The Reels panel is on the Timeline tab on the lower left of the screen.

Reconnect the source clips in the reels
The Reels panel gives an overview of the reels in an EDL. When loading an EDL, SpeedGrade inserts placeholder thumbnails of the source clips in the Reels panel. Reconnect the source clips to the placeholder thumbnails in the Reels panel as follows.

1 If not already done, display the source clips on the Desktop window by selecting the folder containing the source clips.
2 Filter the thumbnails for the media type of the source clips. Example: QuickTime movies.
3 Click the Timeline tab and then click the Reels panel to view the source clip placeholders.
4 Reconnect the source clips to the thumbnails by clicking Load from Desktop. SpeedGrade reconnects the source clips on the Desktop and the video track.

Create a grading clip
When color grading a sequence, work in a non-destructive grading clip associated with the video clips in the sequence. Don’t grade the video clips directly. The grading clip can be saved, moved, and applied to multiple video clips. Grading clips are managed in the Timeline in a grading track above the video track.

To create a grading clip, click the Setup button on the Timeline tab and do one of the following:

❖ To create a series of grading clips in the grading track, click the Extract Grade Clips button in the third column of the Setup window.
❖ To create a grading clip for a single video clip, drag the Grading Clip tool into the grading track above the target clip.

Last updated 12/10/2014
To add grading clips for all the video clips in the video track, drag the Grading Clip tool on a video clip in the video track.

Apply color grades to a grading clip
1 Select a grading clip in the Timeline, not a video clip.
2 Apply color grades to the selected grading clip. For more information on grading, see Quickstart: Color grade a clip.
   The grade is applied to all the video clips sharing the grading clip.
Tip: Compare video clips for shot-to-shot color matching by using multiple playheads. For details, see Compare frames with multiple playheads.

Apply a grading clip to additional video clips
You can apply a single look to additional video clips on the Timeline.
1 Drag the Grading Clip tool from the Timeline tab into the grading track above a video clip.
2 Drag the right side of a grading clip to cover multiple clips.
   Grades in the grading clip are applied to any video clips below it.

Render a graded sequence
1 Click the Output tab in the upper-right corner to open the Metadata Render Engine.
2 Click the Desktop menu and select a destination folder.
3 Assign a name to the rendered file in the File Name text box.
4 In Format & Options, select an output file format for the render.
5 Click Online Quality in the Render tab.
6 Click Render.

Adobe Premiere Pro and SpeedGrade workflows
The color grading process is usually the last step in the post-production workflow. If working with high-resolution material or RAW files, you can begin your workflow by creating smaller proxy files in SpeedGrade for offline editing in Adobe Premiere Pro. After your editing is complete, you can relink the edits to the source material in SpeedGrade for grading and finishing.

General editing and grading workflow
1 Edit in Adobe Premiere Pro.
Send the footage to SpeedGrade as follows:

- If working with compressed files, use File > Send to Adobe SpeedGrade. Premiere Pro renders out a DPX sequence and opens it in SpeedGrade.

  Note: Because a DPX sequence is created, this option is more suitable for shorter projects where you have picture lock and are ready for finishing.

- If working with RAW files or on a larger project, export an EDL. See Export a project as an EDL file in Adobe Premiere Pro Help.

Load the material in SpeedGrade and apply color corrections.

Render out to your final output file format.

Render out a DPX sequence for storage.

You can also import the DPX sequence into Premiere Pro for finishing work such as adding titles and final audio, and then exporting a final master. Importing an uncompressed DPX sequence preserves quality in the event you want to export from Premiere Pro again.

Offline editing and grading workflow

The offline workflow is useful when working with high-resolution material or RAW files.

1 Load the source footage into SpeedGrade.
2 Apply any basic first-light color corrections.
3 Render out proxies. See Create proxy files for offline editing.
4 Import the proxies in Premiere Pro and edit the footage.
5 From Premiere Pro, export an EDL. See Export a project as an EDL file in Adobe Premiere Pro Help.
6 In SpeedGrade, use the EDL to relink the source files. See Multiple-clip workflow.
7 Apply final color corrections to the full resolution source footage.
8 Render out to the file format for your output.

Continuity Checker and Shot Matcher

Continuity Checker

When shooting video, you can have unintended color variations from one shot to another. SpeedGrade lets you even out these differences, and balance the clips such that the video flows smoothly from one clip to the next.

You can quickly compare multiple shots on the timeline using the Continuity Checker, and match the color grading as required. The Continuity Checker is often used in combination with the Shot Matcher feature.

Using Continuity Checker

1 Position the master playhead on a timeline that contains two or more clips.
2 To compare two shots, click 2-Up in the Monitor panel. You can also use the keyboard shortcut Alt+2 (Win)/Option+2 (Mac).
To compare three shots, click 3-Up in the Monitor panel, or use the keyboard shortcut Alt+3 (Win)/Option+3 (Mac).

To remove the additional playheads and view only the current clip, deselect 2-Up or 3-Up, as required. You can also use the keyboard shortcut Alt+1(Win)/Option+1(Mac).

You can view multiple shots on the Monitor panel using the Split-screen option, and see the continuity across shots.

To match the shots and grade the clips, turn on Shot Matcher by clicking Match in the Monitor panel.

**Shot Matcher**

SpeedGrade provides you with a feature called Shot Matcher that lets you automatically match color between two video shots from the same or a similar scene. For example, you can quickly correct underexposed or overexposed footage by using another shot as reference.

The Shot Matcher feature works best when used in combination with the Continuity Checker. You can use the Continuity Checker to compare the two shots, and then match the color between the shots using Shot Matcher.

For example, say, you have shot a video in different light conditions, and you want to match the skin tone of the model between two shots in the same scene. You can compare the two shots using Continuity Checker, and then match the color between shots using Shot Matcher.

See the example images below that demonstrate how the Shot Matcher feature can dynamically color match your footage.

When you use Shot Matcher, SpeedGrade adds an adjustment layer to your grade for that clip. You can adjust the opacity or add additional corrections as required.
Using Shot Matcher
Move the playhead to the frame in your sequence that you want to match. Say, Clip A.

1. Move the playhead to the frame in your sequence that you want to match. Say, Clip A.
2. Create a second playhead. To do so, press the Control (Windows) or Command (Macintosh) key and drag the Move Playhead icon to the required frame in the Timeline. For more information, see Create an additional playhead.
3. Make sure that you move the second playhead to the correct frame to be matched. Say, Clip B. When you do so, the two snapshots to match (Clip A and Clip B) are displayed side-by-side or in a split-screen layout.

Note: Shot Matcher works only when you use two playheads. If you try to use three or more playheads, the Shot Matcher feature is disabled.

4. Select the playhead on the clip to match as the master playhead. For example, select Clip A as the master playhead.

   Note: To select a playhead as the master playhead, click the playhead number. For more information, see Select a master playhead.

5. Click the Match button or use the keyboard shortcut Control (Windows)/Command (Mac)+ M.

A new grading layer “AutoColorMatch” is automatically added to the grading layer stack. You can then enable, disable, remove, or save the look as a preset.

Matching a Photoshop grade
You can now apply a color grade that you create in Adobe Photoshop to your video clip by following these steps:

1. In Photoshop, use all the necessary tools to grade the image, and save the image as a TGA file.
2. In SpeedGrade, reference the TGA file using the new Snapshot browser. A thumbnail of the graded image appears.
3. Move the playhead to the frame in your sequence that you want to match.
4. Click the thumbnail to view the graded Photoshop image in the Monitor view side-by-side with the clip to match.
5. Click Shot Matcher.

SpeedGrade extracts the color grading of the Photoshop image and applies the grading to the selected clip.

Note: If you try to match shots between two distinctly different scenes, you can get inappropriate results.
Snapshot View and Snapshot browser

SpeedGrade provides you a Snapshot view that lets you quickly capture and save still images of clips. You can then use these images as reference, or compare to other clips using a split screen.

You can also import TGA images from other applications such as Adobe Photoshop to use as a reference for color corrections and grading. For more information, see Matching a Photoshop grade.

The Snapshot Browser provides an easy way to store and view images that you save. You can later reference and access these images for your color-grading work.

Using the Snapshot view and Snapshots browser

1. Position the master playhead on the required clip in your footage, and click the Snapshot icon in the Monitor panel. You can also use the keyboard shortcut Shift+C.

2. You can view the snapshot side-by-side on the Monitor view in a splitscreen mode. To turn off the Snapshot View, click the Snapshot icon again.

3. The saved snapshot is saved as a TGA file along with a JPG thumbnail preview (160x45 pixel). You can view the saved images using the Snapshots browser.

   The Snapshots browser provides a collapsible treeview structure with multiple tab support.
The snapshots are stored in the following default locations on your computer file system:

- Mac: /Users/Documents/Adobe/SpeedGrade/7.0/settings/snapshots/
- Win: C:\Users\[user name]\AppData\Roaming\Adobe\SpeedGrade\7.0\settings\snapshots

You can access the snapshots from these locations to share the images.

### Work with masks

#### Apply a mask

A mask isolates a region of an image so that you can selectively grade the region. In SpeedGrade, a mask is attached to a grading clip.

1. Add a grading clip to a video clip in the video track. See [Create a grading clip](#).
2. Click the Mask tab and select one of the mask presets.

   ![Mask presets](image)

   *For a feathered mask, select the Vignette Mask.*

   The Mask widget appears in the Monitor window.

3. Do any of the following to adjust the location, size, and shape of the mask:
   - To reposition the center of the mask, drag the center cross-hair.
   - To expand the horizontal size of the mask, drag the horizontal-arrow control to the right or left.
   - To expand the vertical size of the mask, drag the vertical-arrow control up or down.
   - To rotate the mask, drag the rotational control curve up or down.
   - To expand the feather size of the Vignette mask, drag the outer edge feather rectangle control on the lower-left corner of the widget.

Last updated 12/10/2014
4 Specify the region to grade by clicking the Look tab and select one of the following options in the Layers panel on the left:
   • Apply Grading Layer to the Outside of a Mask (second icon)
   • Apply Grading Layer to the Inside of a Mask (third icon)

   ![Mask & Alpha](image)

   Note: The first icon -- *do not apply the grading to a mask* -- is selected by default. The last three icons on the right specify whether to apply a grading layer to the alpha or inverted alpha channel (neither by default).

5 Grade the region defined by the mask.
   For example, drag the Gamma Level control on the outside of the Gamma Control wheel to darken the outside of a mask.

### Apply additional masks

You can apply additional masks by adding more grading clips to a video track.

1 Add another grading clip to a video track by dragging the Grading Clip icon to the track. See Create a grading clip.

   ![Tip](image)

   Assign names to the grading clips to organize mask assignments. Double-click the string "untitled grading" of each grading clip and specify a name. Example: "Vignette Mask."

2 In the Mask tab, select the new grading clip and then apply a mask and adjust it. See Apply a mask.
   For example, add a circle mask preset and adjust it over a subject's face.

3 In the Look tab, specify whether you want to grade the region inside or outside the mask.

4 Grade the region.
   For example, drag the Gain control outer-wheel clockwise to brighten the subject's face.

5 If desired, apply additional masks by adding grading clips.

### Masking and Tracking

### Masking in Premiere Pro

You can leverage the powerful masking and tracking workflows from After Effects directly within Premiere Pro. Masks let you define a specific area in a clip that you want to blur, cover, highlight, apply effects, or color-correct. You can create and modify different shaped masks, like an Ellipse or a Rectangle. Or, you can draw free-form Bezier shapes using the Pen tool.
You can apply effects either inside or outside the masked area. One of the common uses of masking is to blur a person’s face to protect their identity. For example, you can mask a person’s face by applying a Blur effect or a Mosaic effect.

You can also use masking in more creative ways like applying a mask to correct a specific color. You can use an inverse mask selection to exclude the masked area from color corrections applied to the rest of the clip. In addition, you can add multiple shape masks with different effects to different areas of a clip.

Create a mask using shape tools

Premiere Pro provides you two shape tools: An Ellipse shape tool to create a circular or ellipse-shaped mask, and a Rectangle shape tool to create a four-sided polygon.

1. In the Timeline, select the clip containing the area that you want to mask.
2. From the Effects panel, select the effect that you want to apply to the masked area.
   For example, if you want to apply the Mosaic effect, select Video Effects > Stylize > Mosaic.
3. Apply the selected effect to a clip by dragging the effect icon from the Effects panel to the clip in the Timeline panel.
   Alternatively, select the clip and double-click an effect in the Effects panel to apply it.
   You can apply the same effect multiple times by using different settings each time.

   For more information on applying an effect, see Apply effects to clips.
4. Click the Ellipse shape tool to create an Ellipse-shaped mask or click the Rectangle shape tool to create a rectangle-shaped mask.
   The shape mask appears in the clip displayed in the Program Monitor, and the effect is constrained within the masked area.

Important notes

- Premiere Pro does not save masks as effects presets.
- Masking is disabled for the Warp Stabilizer effect. The mask shape controls do not appear for the Warp Stabilizer effect in the Effect Controls Panel.

Create a free-form shape using the Pen tool

The Pen Tool lets you freely draw complex mask shapes around objects.

Click the Pen tool to begin drawing the mask. You can create different shapes by drawing straight lines and curved segments. To draw smooth curves, you can draw Bezier path segments that provide you greater control over the shape of the mask.

Draw straight path segments with the Pen tool
The simplest path that you can draw with the Pen tool is a straight line with two vertex points. By continuing to click, you create a path made of straight-line segments connected by vertex points.

1. Select the Pen tool.
2. Position the Pen tool where you want the straight segment to begin, and click to define the first vertex point (do not drag).
   
   **Note:** The first segment you draw is not visible until you click a second vertex point.
3. Click again where you want the segment to end (Shift-click to constrain the angle of the segment to a multiple of 45°).
4. Continue clicking to set vertex points for additional straight segments.
5. To close the path, position the Pen tool over the first vertex point. A small circle appears next to the Pen tool pointer when it is positioned correctly. Click or drag to close the path.

**Draw curved Bezier path segments with the Pen tool**

You create a curved path segment by dragging direction lines using the Pen tool. The length and direction of the direction lines determine the shape of the curve.

To create Bezier shapes, you convert a vertex point on a mask to a Bezier point by pressing the Alt key while placing the cursor over the vertex point. The cursor becomes an inverted “V” shape. Then, click and release the pointer.

Bezier handles provide two-directional controls that allow you to change the curve of the line segment between the handle and the next point on either side.

1. Place the Pen tool where you want the curve to begin, and hold the mouse button down. A vertex appears, and the Pen tool pointer changes to an arrowhead.
2. Drag to modify the length and direction of both direction lines for a vertex, and then release the mouse button.
Color grading

3 Place the Pen tool where you want the curved segment to end, and do one of the following:

- To create a C-shaped curve, drag in the direction opposite from the direction that you dragged the previous direction line, and then release the mouse button.

- To create an S-shaped curve, drag in the same direction as the previous direction line, and then release the mouse button.

4 Continue dragging the Pen tool from different locations to create a series of smooth curves.

Modifying and moving masks

The vertex points on a mask let you easily manage the shape, size, and rotation of a mask.

Modify the shape, size, and rotation of a mask

- To change the shape of a mask, drag a mask handle.
• To change the shape of an ellipse mask to a polygon, press Alt and click any of the vertices of the ellipse.
• To resize a mask, place your cursor just outside a vertex and press Shift (cursor becomes a double-sided arrow \[\rightarrow\]), then drag the cursor while pressing the Shift key.
• To rotate the mask, place your cursor just outside a vertex (cursor becomes a curved double-sided arrow \[\rightarrow\]), and then drag. Press the Shift key while dragging the cursor to constrain the rotation in 22.5 degree increments.

**Move, add, or remove a vertex**

• To move a vertex, drag the vertex with the Selection tool. Note that while dragging an ellipse-shaped mask, the ellipse shape is not maintained.
• To add a vertex, place your cursor over a mask edge while pressing the Ctrl Key (Win) or Cmd key (Mac). The cursor changes to a pen shape with a “+” sign. Click to add the vertex to the mask shape.
• To remove a vertex, place your cursor over the point to remove while pressing the Ctrl Key (Win) or Cmd key (Mac). The cursor changes to a pen shape with a minus sign. Click to remove the selected vertex from the mask shape.

**Other important commands and keyboard shortcuts**

• Use the arrow keys on your keyboard to nudge a selected control point by a distance of one unit.
• Press Shift and use the arrow keys to nudge a selected control point by a distance of five units.
• To deselect all the selected control points, click outside a currently active mask.
• To disable direct manipulation of a mask, click outside the mask. Or deselect the clip in the sequence.
• To delete a mask, select the mask in the Effects Control Panel and press Delete on your keyboard.

**Feather a mask edge or adjust mask expansion**

Premiere Pro provides controls that let you adjust mask feathering and expansion directly on the Program Monitor.

The mask position handle lets you move the feather and expansion handles in unison along the mask outline. Using the mask position handle, you can place the feather and expansion controls at a convenient position on the mask.

![Diagram with labels A, B, C, D, E showing feather handle, expansion handle, mask position handle, expansion guide, feathering guide](image-url)
Apply mask feathering

A Without feathering  B With feathering applied

Smooth the edges of a mask shape by applying feathering. Feathering softens the mask selection border so that it blends into the area outside the selection, and provides an aesthetically pleasing result.

The mask feather handle lets you control the amount of feathering directly on the mask outline in the Program Monitor. Premiere Pro displays a feathering guide around the mask outline. The feathering guide is displayed as a dashed line.

You can also specify a Mask Feather value in the Effects Control panel.

Drag the handle away from the feathering guide to increase the feathering, or toward the feathering guide to decrease the feathering.

Adjust mask expansion

Mask expansion lets you expand or contract the area of the mask. The mask expansion guide, displayed as a solid blue line on the Program Monitor, helps you expand or contract the mask area precisely.

Drag the handle away from the expansion guide to expand the mask area, or toward the expansion guide to contract the mask area.

You can also specify a Mask Expansion value in the Effects Controls panel to move the borders of the mask inwards or outwards. Positive values move the borders outward, and negative values move it inward.

Adjust mask settings using Effects Control panel

You can specify values to adjust a mask using the Effects Controls panel. You can track the mask, change the opacity, expand the mask, invert the mask, or feather the mask edges.

Adjust mask opacity

To adjust the opacity of a mask, specify a Mask Opacity value. The slider controls the mask opacity. At a value of 100, the mask is opaque and blocks out any underlying area of the layer. As you lower the opacity, more of the area under the mask becomes visible.
Invert mask selection
Select the Inverted check box to reverse the masked and unmasked areas. You can protect areas that you want to leave as-is by masking it, and select the Inverted check box to apply effects to the unmasked areas.

Copy and paste masks
You can easily copy and paste masks between clips or between effects.

Copy and paste effects with masks between clips
When you copy and paste an effect containing masks, the pasted effect has the same masks applied.
1 In the Timeline panel, select the clip containing the effect with masks.
2 In the Effect Controls panel, select the effect to copy.
3 Select Edit > Copy. Or use the keyboard shortcut Ctrl+C (Win) or Cmd+C (Mac).
4 Select another clip in the Timeline to which you want to paste the mask.
5 Select Edit > Paste. Or use the keyboard shortcut Ctrl+V (Win) or Cmd+V (Mac).

Copy and paste masks between effects
1 In the Effect Controls panel, click the triangle to expand the effect to reveal the applied masks.
2 Select the mask to copy.
3 Select Edit > Copy. Or use the keyboard shortcut Ctrl+C (Win) or Cmd+C (Mac).
4 Select another effect in the Effects Control panel to which you want to paste the mask.
5 Choose Edit > Paste. Or use the keyboard shortcut Ctrl+V (Win) or Cmd+V (Mac).

Note: You can copy and paste only one mask at a time.

Mask tracking in Premiere Pro
When you apply a mask to an object, Premiere Pro can let the mask automatically follow the object as it moves from one frame to another. For example, after blurring a face using a shape mask, Premiere Pro can automatically track the movements of the masked face from frame to frame as the person moves.
When a mask is selected, the Effect Controls panel displays controls for tracking the mask forward or backward. You can choose to track the mask either one frame at a time or until the end of the sequence.

Click the wrench icon to modify how masks are tracked. You can select from a few choices to provide the most effective tracking:

- **Position** Tracks just the mask position from frame to frame
- **Position And Rotation** Tracks the mask position while changing the rotation as required per frame
- **Position, Scale, And Rotation** Tracks the mask position while automatically scaling and rotating as the frame moves

You can find the option that works best for your clip by trial. Select one of these options, and if it doesn’t work well, undo, and try another one.

To use the more advanced tracking features available in After Effects, send your sequence to After Effects using the Dynamic Link feature. For more information, see Mask Tracking in After Effects.

### Video tutorial

**How to blur a moving face with masking and tracking**

In this 5-min video tutorial, learn how to apply a feathered mask to protect a person’s identity and then track that mask as it moves across the frame in a scene.

The tutorial provides you sample files to try out the feature for yourself.

### Track a masked object through a shot

**Track the masked object automatically**

1. On the first frame of the track, apply a mask on the target object and grade it.
   
   For instructions, see Work with masks.
2. In the Mask panel, click the Track Object button.
   
   The button is on the lower-right side of the Mask panel. You might need to scroll the panel down to see it.

The mask automatically tracks the target object through the shot.

See the next section if the following applies:

- The mask can’t follow the object after clicking the Track Object button
- You want the tracking to begin or end later in the shot

**Control the movement of a mask manually**

Use keyframes to manually control the position of a mask over time. A keyframe marks the point in time where you specify the shape or position of the mask. You typically use at least two keyframes—one for the position at the beginning of the change, and one for the new position at the end of the change. SpeedGrade animates the transition between the keyframes. For more information, see Work with keyframes.
Keyframes are useful when the target object cannot be followed automatically. You can also use keyframes to change the shape and feather of a mask over time.

1. In the Mask panel, do the following:
   a. Move the playhead to the position on the timeline where you want the mask to start tracking the object.
   b. Click the Record Keyframe button to insert a keyframe.

   ![Record Keyframe Button]

   **Note:** You don't have to insert a starting keyframe if you want the mask to track the target object from the first frame of the track. SpeedGrade adds a keyframe to the first frame as soon as you add a grading clip.

2. Apply a mask over the target object at the keyframe, and then grade the mask in the Look panel.
   For instructions, see [Work with masks](#).
   - If you want the mask to track the object automatically from that point forward in the shot, click the Track Object button on the lower-right side of the Mask panel.

3. Insert a second keyframe in the timeline as follows:
   a. Switch to the Mask panel and move the playhead to the second position on the timeline where you want the movement of the mask to end.
   b. Click Record Keyframe.

4. Reposition the mask over the target object at the second keyframe.

5. To create a dissolve between the two keyframes, click the Record Keyframe button a second time on the second position.
   SpeedGrade indicates the dissolve with an arrow on the track between the two positions.

6. If necessary, add more keyframes and adjust the position of the mask at each keyframe.

**More Help topics**
- Work with masks
- Work with keyframes
- Color grade a clip

**Adjust color temperature**

Adjust the color temperature by dragging the Color Temperature slider in the Look panel.
If the image is too warm, lower the color temperature by dragging the Color Temperature slider to the left.

If the image is too cool, increase the color temperature by dragging the Color Temperature slider tool to the right.

Balance blacks and whites

Balancing blacks is the first step in the color correction workflow. You can use the Offset color wheel or the vertical slider in the Look panel to balance blacks.

Once the blacks look good, move on to balancing the whites. Use the Gain color wheel or vertical slider in the Look panel to balance whites.

Note: To use RGB sliders instead of the color wheels. Click the Sliders mode button on the upper-left of the coloring tools.

Use the RGB Parade scope to guide your adjustments. To display the RGB Parade scope, open the Analysis Tools panel by pressing the A key. For more information, see RGB Parade.
Set black balance
In the Look panel, you can use the Offset color wheel or vertical slider to normalize color levels in shadows.

Drag the hue control tool in the center of the Offset color wheel by doing the following:

1. Right-click inside the wheel and release the click button.
2.Swipe the mouse in any direction to change the value.
3. Right-click again to accept the setting

You can also control the Offset color wheel by moving the vertical slider up and down.

Example
If the image is tinted yellow in the shadows, push the Offset hue control tool toward blue to balance the black values. The adjustment results in the following waveform change.
**Set black level**

In the Look panel, drag the triangle icon on the Offset control wheel until the valleys of the waveform rest on the 0 level of the waveform display. Drag clockwise to raise the valleys or counter-clockwise to lower the valleys.

To move the triangle icon on the color wheel, drag it left or right in a straight line. Don't drag in a circle. The further left or right you drag, the larger the change.

Moving the valleys below the 0 level eliminates details in the shadows.

**Example**

![Waveform example](image)

**Set white balance**

In the Look panel, drag the hue control tool in the center of the Gain color wheel to normalize color levels in shadows.

![Color wheel](image)

To move the hue control tool, do the following:

1. Right-click inside the wheel and release the click button.
2. Swipe the mouse in any direction to change the value.
3. Right-click again to accept the setting.

Use the RGB waveform as a guide to adjust highlight color values. In the following example, the blue waveform is lower than the red and green ones.

![RGB waveforms](image)

Pushing the gain hue control tool toward cyan and blue balances out the shadows.

**Set white level**

In the Look panel, drag the triangle icon on the Gain control wheel until the peaks of the waveform touch the 100 level of the RGB waveform display. Drag clockwise to lift the peaks or counter-clockwise to lower the peaks.

Last updated 12/10/2014
Color grading

To move the triangle icon on the color wheel, drag it left or right in a straight line. Don’t drag in a circle. The further left or right you drag, the larger the change.

Or you can move the vertical slider up and down.

Moving the waveform above the 100 level blows out the whites and eliminates details in the highlights. Example:

![Waveform Image]

**Adjust gamma**

Gamma is the relative bright and dark value of the image.

Adjust the gamma setting by dragging the triangle icon on the Gamma color wheel in the Look panel. Drag clockwise to lower the gamma setting or counter-clockwise to increase it.

![Gamma Color Wheel Image]

To move the triangle icon on the color wheel, drag it left or right in a straight line. Don’t drag in a circle. The further left or right you drag, the larger the change.

Use the RGB waveform to guide your adjustments. To display the Waveform panel in the Monitor view, press the W key. For more information, see RGB Parade.

If the image appears milky, flat or lacks punch, increase the gamma setting by dragging the triangle icon counter-clockwise.

If the image has punch but lacks shadow detail, lower the gamma setting by dragging the triangle icon clockwise.
Grade a specific tonal range

You can make color corrections to a specific tonal range, such as the highlights, shadows, or midtones.

1. Select Shadows, Midtones, or Highlights on the upper part of the Look panel.

2. Make color corrections using the color wheels and sliders.

3. Extend or limit the affected tonal range using the slider on the right side of the color wheels.

For example, if grading in the shadows, pushing the slider up extends the changes into the midtone region of the image. Pushing the slider down limits the changes deeper into the shadows.
Secondary color correction

Apply filters and effects

Use filters and effects to quickly apply advanced grading styles to clips.

1. Load a clip on the Timeline.
2. In the Layers panel on the Look tab, click the + icon and then select an effect or filter from the menu.
   The + icon is on the lower part of the Layers panel.

3. Modify the effect or filter with the grading tools in the Look panel.
   *Note: The tools available vary depending on the effect or filter you selected.*

4. Adjust the strength of the effect or filter with the opacity slider on the upper side of the Layers panel.

Adjust the framing of shots with pan and scan

Use pan and scan to adjust the framing of your shots for different output formats. You can reposition, scale, rotate, and skew your image to fit best into other frame format.

Use keyframing to make adjustments within a shot or from shot to shot. For more information, see Work with keyframes.

Create a pan and scan track

1. Drag the Pan & Scan button on the timeline to create a pan and scan track. The Pan & Scan button is on the Timeline panel, under Timeline Elements.
A green Pan & Scan track appears on the Timeline.

2 Click the pan and scan track to open the Pan and Scan panel.

3 Select the output format from the Crop Preset menu.

Note: You can enter any other format in the Crop text box.

4 Use the Pan and Scan widget to position, scale, rotate, or skew the image within the new frame format. The widget works like the Mask Widget. See Apply a Mask to learn more about using the widget.

Note: The Pan and Scan widget does not have all the functionality of the Mask widget. For example, the feathering and spline nodes are not available.

You can also apply Pan and Scan adjustment numerically in the Pan & Scan panel. Click the R button to reset to default.

Change pan-and-scan adjustments along a clip

The pan and scan track is a global track along the entire timeline. Any pan-and-scan adjustments affect the whole clip. Use keyframes to change the adjustments along the clip. For details on using keyframes, see Work with keyframes.

The typical workflow for making pan-and-scan adjustments along a clip consists of the following steps.

1 Create a keyframe at the beginning of the clip.

2 Create another keyframe at any position further along the timeline where the settings should no longer be effective.
Create a dissolve from one keyframe to the next by pushing the Record Keyframe button a second time at the second position.

Adjust the pan-and-scan settings at the two keyframe positions.

Pan and scan preview options
You can choose from three different preview options from the Crop Preview menu: Normal (crop), Transparent, and Outline. Select the view that best serves your project.

Grade a specific color range
Secondary color corrections are applied to specific color ranges within your images. They let you accent, modify, or tone down parts of an image.
For a video, see Secondary Color Correction by Patrick Palmer.

Select and grade a color range
1 In the Look panel, click the +S icon to add a secondary grading layer.
2 Select a color range to target. Do one of the following to select a range:

a Choose a preset color range from the range selector.

Note: You may have to scroll down the Look panel to see the range selector.

If none of the six standard colors is a good starting point, click the gray button on the right side of the selectors to see more options.

You can also deselect the Hue, Lightness, or Saturation options. This is useful for targeting a specific luma zone for grading. For example, turning off Hue and Saturation gives you a clean lightness key.

b Sample a color range in the image. Click the sample range button (the eyedropper icon with the plus sign), hold down the left mouse button, and move over the color range you'd like to sample. Release the mouse button when you're done.

3 Use the Grey-out options in the right corner of the Look panel to view the selected region of the image.

4 Expand or restrict the target color range by dragging the Hue, Lightness, and Saturation sliders.

The top sliders move the entire selected range. The bottom sliders feather the selection.

5 Color correct the target range using the grading tools such as the contrast slider or the Offset color wheel.

Example: Isolating skin tones with secondaries

1 Add a secondary grading layer by clicking the +S button in the Look panel.
2 Sample skin tones by clicking the sample range button (the eyedropper icon with the plus sign), holding down the left mouse button, and dragging a rectangle across a range of skin in the image.

The range selector sliders display the sampled color values:

3 View the selected region of the image by selecting the Color/Gray option in the Gray-out menu.

4 Adjust the range selection by dragging the Hue, Lightness, and Saturation sliders.
   For example, you want to work on a narrower range of skin tones.

5 Smooth out skin blemishes and wrinkles by dragging the Blur slider to the right.

6 Warm up skin tones by dragging the Offset hue control toward yellow.

**Stereoscopic workflows**

*Stereoscopic workflows*
Chapter 5: Managing looks

Working with Looks

Share and reuse looks

SpeedGrade can save color grading information in .Look files for reuse. Because the files are small, you can easily store them or share them with others.

Save and share a Look

Save a Look
1 Grade some material.
2 In the Look tab, click the Save Look button on the lower right side of the Layers panel.

You can also press Ctrl+P (Windows) or Cmd+P (Macintosh) to save the Look file.

The .Look file appears in the Look browser as a thumbnail. The default location for the files is ../SpeedGrade/settings/looks.

Note: If you get an error that the folder is read-only, close SpeedGrade and then run it as administrator. In Windows, right-click the start icon and select Run as Administrator.

3 If desired, rename the .Look file by clicking the current name and typing a new name.

Share a Look
1 Locate the .Look file to share. The default location of .Look files is ../SpeedGrade/settings/looks.
2 Send the file as an email attachment or move or copy it to a shared folder in the Cloud or on a network.

Last updated 12/10/2014
Managing looks

Use the Look Manager

The Look Manager lets you effectively organize, view, or minimize the Look presets that you save.

You can choose from the following three different views to display Look presets:

- Look Management View
- Quick View
- Minimized Browser View

Look Management View  Displays the Look presets as thumbnails in multiple rows. You can view several .look files at once. You also have a tree-view navigation structure to set the default Looks folder.

Quick View  Displays Look presets as thumbnails in a single row

Minimized Browser View  Displays the Look Manager in a tabbed-browser view without displaying any thumbnails. This view gives the Monitor panel more screen space for your grading work.

Apply a Look

Apply a Look in SpeedGrade

1  Select a clip or grading track.
2  In the Look Manager, navigate to the folder containing the .Look file you want to use. Use the left and right arrow keys to navigate to more folders.
3  Click on the .Look file to apply it.

You can also drag the .Look file on the Timeline. It appears as a grading clip that you can resize and reposition to apply the look across multiple clips, scenes, or a whole project.

Last updated 12/10/2014
Hover to preview a Look
1. If you hover over a Look thumbnail, you can view how that Look impacts your image in the monitor. This makes it incredibly easy to test and compare Looks.
2. To apply the Look, click on it. Alternatively, you can drag the Look thumbnail into the grading layer stack, where it appears as a new Group, and is automatically applied to the image.

Apply a Look in After Effects
Adobe After Effects supports native .Look files.
1. With footage open in After Effects, select Effect > Utility > Apply Color LUT.
2. Select the .Look file from your hard disk.
   To blend the look in After Effects, create an adjustment layer above the clip in the Timeline, then apply the look (Effect > Utility > Apply Color LUT). In the Timeline, select the adjustment layer, then press the T key to bring up the transparency control. Adjust the transparency to blend the look.

Apply a Look in Photoshop
Adobe Photoshop supports native .Look files.
1. With an image open in Photoshop, select Image > Adjustments > Color Lookup.
2. In the Color Lookup dialog box, select the Load 3D LUT option.
3. Select the .Look file from your hard disk and click OK.
   For more control over the look, create a Color Look Up adjustment layer. Select Layer > New Adjustment Layer > Color Lookup, and then select the .look file from the context menu.

Export a Look
You can export a .Look file with one or more LUT files to use in Adobe Premiere Pro or a third-party application.
*Note: LUTs do not include masks or effects such as blur or glow.*
1. In the Look Manager, right-click (Win) or Ctrl-click (Mac) the .Look file and select Export Look.
2. Select additional files to include, and click Export.
   SpeedGrade creates a zip file containing the files.
*Note: A LUT is not required if you’re sharing a look with After Effects or Photoshop, which support native .Look files.*

Delete a Look
You can delete a saved Look by following these steps:
1. In the Look Manager, right-click (Win) or Ctrl-click (Mac) the .Look file and select Delete Look.
2. Confirm the deletion.

Apply Looks with Looks Manager
Chapter 6: Rendering out

Rendering out your project

Create proxy files for offline editing

For a faster workflow, you can work on low-bitrate proxy files ("proxies") rendered from high-bitrate master files. This article describes how to create proxy files for offline editing while preserving both the original file naming and source time code.

1 Move all the source clips to the Timeline as follows:
   a Browse to the source folder in the SpeedGrade Desktop.
   b Click the Add All button on the lower-right side of the Desktop.
2 Define the output folder for the rendered proxy files as follows:
   a Select the Output tab.
   b Specify an output path in the Folder field with the breadcrumb control.
3 Instead of typing a file name for the proxy files, specify the following file naming option:
   a In the File Name field, click the M icon for lists of preset metadata tags.
   b Select the “Src.PathElement.0” option.
   This option splits the Timeline into individual QuickTime files for rendering. It also matches the output file name to the source file name.
4 Set the Time Code Source to the Source option to preserve the master file time code information.
   You can also set the time code source to other time code generators based on the workflow.
5 Select the output format, calibration lookup table (LUT), and framing settings as with any regular render job.
Rendering Out

6 Select Online Quality or Offline Quality and then click Render.

Save an EDL

You can export an Edit Decision List (EDL) of assembled clips from the Timeline.

1. With two or more clips on the Timeline, click the Setup button on the Timeline panel.

2. In the Tools panel on the right side of the panel, click Save EDL.

3. Name the EDL, select a folder, and click Save.
Chapter 7: System Requirements

System requirements for SpeedGrade

System requirements for SpeedGrade